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Accessing Q-Content 
 
URL: http://www.jacksongov.org/controls 
Use Internet Explorer – no other browser 

 

 
 
 

Login: 
 
Username: _______________________________________________ 
 
Password: _______________________________________________ 
 
 
Both are case-sensitive. 
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The Q-Basics 
 
After logging in, you will access the Q-Content program utilized for maintaining jacksongov.org and 
all its “sister sites” – jacksongov.org/sheriff, combatjack.org, makeyourdayhere.com, etc. 
 

 
 
A – These are your navigation folders, with those in the square shown here being the folders for the 
main site, jacksongov.org. 
 
Those folders with a “globe” are the ones that appear in the site’s navigation: HOME, I WANT TO…, 
E-SERVICES, etc. 
 

 
 
Folders lacking this globe symbol are “hidden” in that they do not appear in the navigation. 
 
Access to creating new folders will be restricted because of the potential for breaking a site’s 
navigation. For example, adding another “globe” file to jacksongov.org, might cause the navigation to 
extend beyond the boundaries of the limited horizontal space available for the navigation. 
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A – MORE ABOUT THE NAVIGATION 
Q-Content was created to accommodate one website, but we are utilizing it for six: 
 
 County’s MAIN Site – jacksongov.org 
 Prosecutor’s Site – jacksongov.org/prosecutor 
 Sheriff’s Site – jacksongov.org/sheriff 
 COMBAT – combatjack.org (a.k.a. jacksongov.org/combat) 
 Parks + Rec – makeyourdayhere.com (a.k.a. jacksongov.org/parks) 
 Economic Development – jacksongov.org/econdev 

 
We’ve been able to work around Q-Content’s one site limitation by making all other sites a “site 
within the site” – all under jacksongov.org. Thus, we have jacksongov.org/combat, /prosecutor, etc. 
 
To help sort out the “sites within a site,” you’ll notice that the navigation folders have been sorted in a 
way that all the MAIN folders appear at the top (inside the “A” box). 
 
All the “sister site” folders are labeled “SITE” – as in  “SITE - COMBAT” and “SITE – Prosecutor.” 
If you are editing the Sheirff’s site, for example, click on the “SITE – Sheriff” folder to gain access 
and open the sub-folders. (Each “sister site” has been programmed to begin its navigation with the 
corresponding folder, with the COMBAT site’s navigation beginning with the “globed” sub-folders 
under “SITE – COMBAT.) 
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B  – You’ll utilize these menus when actually making edits to the content. The “Tools” option is for 
making edits to the site as a whole. You are not to use the “Tools” menu. (More about “File” and 
“Edit” later.) 
 
C – CONTENT MANAGEMENT 
This is the tab you’ll be doing most of your work in, for this is where you gain access to already 
existing content and to post new web pages. 
 
D – FILES AND DOCUMENTS 
You’ll use this tab to load files/documents such as PDF’s and Word documents onto the website. 
 
E – DRAFTS 
You access your drafts here and can preview content as it’ll appear on the website, prior to being 
published and going live. 
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Accessing Content 
 
To open a folder, click on it until it is highlighted, and then you’ll see all the sub-folders A associated 
with it. If you are working in a “SITE” folder, the sub-folders will correspond with that website’s 
navigation B. Those folders lacking the globe symbol C are hidden and, therefore, do not appear in 
the navigation.  
 
 

 
 
D  – The “Default” is the web page that corresponds with that folder. For example, if you go to the 
“About Us” page for jacksongov.org/prosecutor – the “Default” page will feature the content one 
views with clicking on “About Us” in the Prosecutor’s navigation. 
 
All other content you view listed under “Default” is what Q-Content refers to as “independent 
content,” such as all articles that would be posted under “News” but are not directly accessible via the 
website’s navigation. 
 
Independent content is actually dependent on a link being placed somewhere on your site, if visitors 
are to be able to access that page without using the search engine. 
 
E  – If you click on this “Copy Hyperlick” button you’ll get the LINK associated with that web page – 
“/content/9109/9260/9264.aspx,” for example. This is essential for later inserting links to that page. 
 
Your access to folders will be restricted, with not everyone being able to edit the Prosecutor’s content, 
Sheriff’s, etc. 
 
TO EDIT CONTENT… 
 
Double-click on the default or another title listed under “NAME” D 
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Special Note About Accessing Content 
 
Some of our sites have split navigation, meaning that their navigation does not appear in a single 
continuous line. This is clear on Parks + Rec with its two lines of navigation: 
 

 
 
It’s less obvious on the Prosecutor’s site. The menu bar here is split in two with the Prosecuting 
Attorney seal being the divider: 
 

 

 
Because Q-Content bases its navigation off the folder structure, to generate the “split” for these two 
site’s there are TWO “SITE” folders for both Parks + Rec and the Prosecutor. 
 
SITE – PROSECUTOR 
Contains all the content to the left of the seal: 
 About Us 
 Contact Us 
 News 
 Prosecuting A Case 
 
SITE – PROSECUTOR 2 
 Community Engagement 
 Victim & Family Resources 
 
SITE – PARKS + REC 
Contains all the content on the top navigation bar: YOUR PARKS, YOUR LAKES, etc. 
 
SITE – PARKS + REC 2 
Contains all the content on the lower navigation bar: Home, About Us, Parks Safety, etc. 
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What if you need to edit a page, but don’t know in which folder to locate it? 
 
Q-Content includes a shortcut that allows you to go directly to the page you want to edit – via the 
“Edit” menu option: 
 

 
 
 
Scroll down to “Edit Content From URL.” 
 

 
 
Paste in the URL of the page that needs to be edit, then click the “EDIT” button. 
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Q-Editor 
 
When editing previous content or creating new content (page 18), you’ll be accessing the Q-Content 
editor page. 
 
Let’s break it down. 
 

 
 
Dynamic Content 
 
This is where you’ll apply your template(s) to your page. There are more than 100 templates being 
used in jacksongov.org. Note the ones to use for your content here: 
 
______________________________________________________ 
 
______________________________________________________ 
 
______________________________________________________ 
 
______________________________________________________ 
 
Content Name & Content Title 
 
Think of these as the headline for your web page. I generally use the same text for both. 
 
Meta Description & Meta Keywords 
 
Description: Search engines such as Google will seek this out, so it is crucial to include this. (I wish it 
were a required field.) To improve our search engine performance, I would, for example, proceed all 
prosecutor descriptions with “Jackson County Prosecutor:” and then add on the Content Title. That 
way “Jackson County Prosecutor” is being listed on dozens, eventually hundreds of web pages for the 
search engines to then seek out. 
 
Keywords: They are just that. Again for the Prosecutor’s website, I might list words like justice, law, 
crime, the names of people specifically mentioned on the web page, etc. 
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Link Tools 
 
These are you Link (left) and Unlink (right) tools. The unlink tool features the broken chain symbol. 
 
>>> CREATING A LINK – Page 15 
 

 
 
Photo-Insert Tool 
 
>>> INSERTING A PHOTO – Page 30 
 

 
 
Symbols Tool 
 
Use to insert symbols such as trademark ™and copyright ©. 
 

 
 
Content-Template Tool 
This is a poorly named tool, for you don’t use it to apply a page template to the web page you are 
creating. (You do that in the “Dynamic Content” section.) Inaccurate name, aside, this is a very 
important shortcut tool for inserting photo boxes, formatting pages and other items. MUCH MORE 
about this on page 25. 
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Word Tools 
 
I call these the “Word Tools” because they function very similarly to the corresponding tools in 
Microsoft Word. Use them sparingly. Bold-facing and italicizing text are OK. Never use the underline 
tool – NEVER-EVER! Underlined text signals on a website that the text is a link. (If I could, I would 
delete this underline option from this tool-set.) 
 

 
 
Inset/Bullet Tools 
 
You can use these to create bullet lists and to inset text. The inset function can be tricky, so use it 
infrequently. Works very much like Microsoft Word. 
 

 
 
Publish – Save As Draft – Return To List Buttons 
 
These are located at the very bottom of the editor window: 
 
Publish – This will “publish” the page to the LIVE site with the changes you’ve made. 
 
Save As Draft – This will keep the current content live on the site and place a copy with the changes 
you’ve made in the draft folder. You can then look at the page in the draft folder, preview it (in the 
template) and then decide to publish. (More about drafts on page 22.) 
 
Return To List – If you press this, all changes you’ve made to a page will be wiped out. I generally 
only use this button when I’ve inadvertently opened the wrong page. 
 
Hitting Ctrl-S will not save your changes as you work. 
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Working With Our Style Sheets 
 

 
 
Avoid manually formatting text via selecting fonts, font sizes, colors, etc. 
 
Each of our websites has a cascading style sheet (CSS) – one for the main site, Sheriff’s site, 
Prosecutor’s site, etc. But the Q-Content editor only allows us to use one master style sheet in the 
editor. To work around this restriction, we’ve incorporated all the styles for each site into this single 
style sheet. 
 
To apply a style, you highlight the text and then go to the Apply CSS menu (above). 
 

 
 
To separate out the different styles used on our different sites, I’ve interested headers into the CSS. 
 
 MAIN 
 COMBAT 
 SHERIFF 
 PARKS 
 PROSECUTOR 
 MISCELLANOUS  
 
If you are working on the COMBAT website, for example, only use the styles listed between 
COMBAT and SHERIFF – and that feature a COBMAT_ tag. 
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Some styles are available to use on all sites, and they are listed above the MAIN header. They 
include: 
 
 Clear Class: This isn’t actually a style, but a tool for clearing the styles already applied to a block 

of highlighted text. 
 

 Copy_600: Allows text to only be 600 pixels wide. It’s a rarely used style and used primarily to 
prevent text from being spread across the entire width of a monitor when using an “open” template 
without set boundaries. 
 

 Single_line_p: Don’t use. It’s a buggy style. I’m still trying to work out the bugs. 
 

 Photocutline: For use in photo captions. 
 

 Photo-right: To be used with photos when flushing them to right. It automatically formats the 
photo – placing a border around it, flushing the image to the right and wrapping text around the 
image. (To only be used with photos that don’t need a cutline.) 
 

 Photo-left: Does everything that Photo-right does, expect flushes the photo to the left. (To only be 
used with photos that don’t need a cutline.) 
 

 There’s one other photo style (just a clear box) that appears directly above the MAIN header 
and just below the “Photo-left” style. Use for placing a frame around an image.  
 

 
 
See page 30 for more about inserting a photograph. 
 

 
Special Note About Using Styles 
 
Look closely at the areas of the website you’ll be editing. You’ll be able to see how styles have been 
applied to the site – and how you should then apply them in Q-Content. 
 

DO NOT cut/paste from a Word document directly into Q-Content. You can write articles/other 
content in Word, but it is crucial not to cut/paste from Word into Q-Content. Doing so will result in 
unnecessary “junk” code being imported into your Q-Content pages – junk code Q-Content will often 
fail to scrub out. 
 
Instead, paste your content into Notepad (found under “Accessories” in your list of programs), then 
from Notepad copy and paste into Q-Content. This strips out all of the Word code. 
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Inserting A Link 
 
1) In the page editor, highlight the text or image/graphic that will serve as the link. 
 
The Kansas City Police Department is a partner of the Prosecutor’s Office. 
 
2) Click on the link tool (left), which opens this window: 
 

 
 
3) Insert the URL for the link 
 
4) Select a “Target” based on these criteria: 
 
 If the link is going to a page within your website – e.g. from Parks + Rec beaches to Parks + Rec 

lakes – click on “Same Window.” 
 

 If the link goes to another site – e.g. from the Sheriff’s site to the Missouri Highway Patrol – click 
on “New Window.” You don’t want to close the Sheriff’s site to open up someone else’s site.  
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5) Include a Tooltip: 
 

 
 
After inserting the URL for the link A and selecting a target B (a new window, in this case because 

the link goes outside of jacksngov.org), you then need to write a “Tooltip” C. This tip is read by visual 
readers to help the visually impaired know that the highlighted text/graphic is a link. 
 
6) Apply style to the link: 
 

 
 
You want to apply a link style from the CSS Class sub-menu to your link. Link styles include the 
chain-link symbol. I generally use the bold style for a link within a paragraph: 
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I use the “red” link style for the “> MORE” links at the end of news briefs – like those on the home 
page of jacksongov.org/prosecutor and the “News” page of jacksongov.org: 
 

 
 
Note: Because red is a pre-dominant color already being used on the COMBAT website for headlines. 
I’ve created a “COMBAT_More” link style for this purpose. It’s gray and prevents us from overdoing 
the red on the COMBAT site. 
 

 
 
The other most commonly used link style is “blank_blue,” which I’ll use in listings: 
 

 
 
As this image shows, when you mouse over most link styles, the text changes – in the case of 
“blank_blue” to underlined red text. 
 
When you do not apply a style to a link, the default style will be blue underlined text: 
 

  
 
I generally don’t like the default option because a lot of underlined text can be difficult to read. 
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Adding New Content (3-Col. Template) 
 
First of all, by a 3-Col. template, I am referring to templates that create a basic 3-column web page: 
 

 
 
The template automatically creates the three columns – 1, 2 & 3. In Q-Content you’ll be editing the 

second column space 2. 
 
Templates can only be edited and created outside of the Q-Content editor. 
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Step-By-Step Directors For Adding New Content (3-Col. Template) 
 
1) Select the folder you want to work in. For example, the “News” folder on the 
jacksongov.org/prosecutor website: 
 

 
 
To the right you can see all the content associated with that file, including the “Default” page that 
appears whenever a visitor to jacksongov.org/prosecutor clicks on “News” in the navigation. Below 
“Default” are listed all the articles (Independent Content pages) in the news folder – in this case the 
news articles posted onto the website. 
 
2) You want to post a new story. Go  to the File menu and select “New,” then “Content.” Be sure you 
are using the Q-Content “File” menu and not the “File” menu for Internet Explorer. 
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3) You’ll being starting with an entirely blank page and will need to fill in each field of the Dynamic 
Content section (page 10): 
 
3a – Select your template. Templates are listed in the order in which they were created, not 
alphabetically. Refer to the list you made on page 10.  
 

 
 
3b – Fill in the fields for Content Name, Content Title, Meta Description and Meta Keywords. DO 
NOT skip the two “Meta” fields. (page 10) 
 
4) Copy & Paste Text 
 

 
 
Again, do not copy/paste from Word. Use Notepad. 
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5) Stylize Text 
 

 
 
Highlight the text you want to style and then under “Apply css…” scroll down to the style you want to 
apply. (See page 13) 
 
6) If needed, insert photo(s). (see page 30) 
 
7) When you are completed you can… 
 

 
 
Publish the page to go LIVE with it or Save As Draft to save the web page under the Drafts tab. 
 
If you click on the Return To List button, you will wipe out the work you’ve done and will be unable 
to retrieve it. (There is no secondary warning box – “Are you sure you want to do this?” – when you 
press Return To List. You are just instantly bounced out of the editor and back to the Content 
Management tab.) 
 
 
Special Note Regarding Photographs / Tables 
 
1) Photos and Tables to be used on a three-column page can be no more than 595 pixels wide if 
centered. 
 
2) No more than 400 pixels wide if they are to be flushed to the left or right with text then wrapped 
around them. 
 
EXCEPTIONS: 
 
The Prosecutor’s site does not use three-column templates. Therefore, these size restrictions do not 
apply. 
 
The Parks + Rec. three-column pages are slightly narrower. Therefore, the size limitation is 560 pixels. 
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Working With The Drafts Tab 
 

 
 
The Drafts tab lists all the “drafts” you have saved – and those drafts will continue to be listed here 
until the page they are associated with is “published,” eliminating the draft with a new live version of 
the page. 
 
Pressing the “Preview” link at the far right will enable you to view the draft in a live-site rendering, as 
it would appear on the site if it were “published.” 
 

 
 
This allows you review the draft before publishing it and allowing the public to access the web page. 
For example, you would want to eliminate the gap here between the “Frequently Asked Questions” 
sub-header and the bulleted list of links. 
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When you “Preview” a draft, you can copy the “preview” URL from the page and share it with others 
for review. 
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Adding New Content (2-Col. Web Pages) 
 
Two-column web pages: 
 

 
 
These templates automatically create just two columns – 1 & 2. In Q-Content you’ll be editing all the 

second column space 2. These templates allow for elaborate designs, larger graphics, etc. 
 
This represents what I would call a “stacked” 2-column page with: 
 
2a – This “stacked” feature being the photograph at the top of the page: 
 
 Limited width of 785 pixels 
 No more than 750 pixels wide (Parks + Rec) 
 
2b left and 2c right columns: 
 
You want to split the second column in two because you do not want to have a big block of text 
running clear across the screen at 785 pixels wide. Text lines more than 660 pixels wide are generally 
considered too wide to be easily read. One or two lines of text – no more than three or four – that are 
785 pixels wide are OK, but when you start getting into blocks of five lines or more are just too much. 
 
There’s several ways to split the second column in two: 
 
 You can have text and photo columns like what is shown above. 
 You can have the main article in one column and a sidebar story in the other. 
 You can have the main article in one column and “Related Links” in the other. 
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How To Quickly Format A 2-Column Page 
 
Formatting a 2-column page can be daunting if done manually, involving table-building, HTML code-
writing, etc. 
 
Fortunately, there is an easier way: The inaccurately named Content-Template Tool. 
 

 
 
Don’t confuse this with applying a template in the Dynamic Content window (page 10).  The template 
you apply in Dynamic Content is a page template like this:  
 

 
 
The template features the basic structures of the web page: 
 
A – The header 

B – The location of  the search box 

C – Location of the navigation 

D – Content to be included in left-hand column 

E – Content to be included in the right-hand column (with the right-hand column eliminated  
        in 2-Col. pages.) 
 
Q-Space – This is the space you are editing in the Q-Content editor to fit within the confines of the 
page template. 
And in two-column templates you’ve got a lot more space to work with: 
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And the Content-Template Tool is how you can quickly format your Q-Space – all of the 2 space 
above – in a 2-Col. template. 
 

 
 
Let’s Take This One Step At  A Time 
 
1) Just as you did with a 3-Col. page, select the correct folder in the navigation and then use the “File” 
menu to select New > Content. (page 19) 
 
2) Fill-in the Dynamic Content fields. (page 10) 
 
 Be sure you select a 2-Col template. 

 
3) Now you can turn your attention to formatting the page via the Content-Template Tool. 
 
Here’s how it works: 
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 When you click on the tool -  - this window will appear: 
 

 
 
You can select any of several pre-formatted “Content Templates” to use as the basis for creating 
your new page. Select the template you want to use and then press: “Insert Template” 
 
The Insert Content Template window includes thumbnail images giving you some indication of 
what each format looks like when applied. 
 

 The format – “Content Template” – you select will automatically being inserted into the Q-Content 
editor: 
 

 
 
At this point, it’s a matter of just inserting your headline, text and photos in the placeholders 
provided by the “Content Template” with some resizing of table and column widths possibly 
needing to be done (page 21). 
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SPECIAL NOTE: These “Content Templates” are generally set up for the main website, but can 
be applied for jacksongov.org/sheriff and jacksongov.org/combat. Headline and other text styles 
will simply need to be changed. 
 
Special “Content Templates” specifically designed for the Prosecutor’s site have a “Pro_” prefix 
and those for Parks + Rec have a “PR_” prefix. 

 
Quick Tips When Reformatting A Content Template 
 
1) Headlines: 
 
Don’t highlight the entire headline and then type in your new headline. Highlighting the entire 
headline will sometimes cause the headline to lose it CSS style formatting. Therefore, try to highlight 
all the letters except the first and last in the headline. It can sometimes be tricky to highlight all but 
those two letters. The main thing is to just make sure the first and last letters aren’t highlight: 
 

 
 
Now you can type in your new headline: 
 

 
 
Then use your backspace and delete keys to remove the old first/last letters. 
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2) Text: 
 
Regarding standard text blocks, you can highlight all the text in them and then cut/paste over the 
highlighted text directly from Notepad (page 20): 
 

 
 
Then you can go about stylizing the text (page 21) and inserting links (page 15). 
 
3) Photos 
 
>>> See page 30 
 
4) Save as a draft (page 21), review and publish (pages 22-23). 
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Uploading/Inserting Photos 
 
To insert a photo, you need to first place your cursor at the point in the article where you want the 
photo. With the exception of photos that will be centered, this insertion point has to be at the start 
of a paragraph: 
 

 
 
Once you’ve inserted your cursor, press the image tool: 
 

 
 
This Image Manager Box Will Open: 
 

 
 

 
For the purpose of this manual, we are going to describe how to load a photo for the Prosecutor’s site. 
 
1) In the images folder, you are going to scrolled down to the Prosecutor sub-folder. 
 
 You can create a new sub-folder via this button (A). Be sure you are creating the new sub-folder in 

the folder related to your site: Prosecutor, Sheriff, COMBAT, etc.  
 

 To load a new photo into your folder or sub-folder press the Upload button (B). 
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2) When you click “Upload” this window opens. You can load up to three images at a time. While Q-
Content allows for a multitude of file formats, you want to stick with jpeg or gif formatted images. 
Most will be jpegs. 
 
 

 
 
 
 BEFORE UPLOADING PHOTOS: Your images need to be formatted prior to being uploaded. 

 
>>> Resolution: 72dpi 
 
>>> When saving your photos, do not use spaces. Instead use underscores: 
         
         prosecutor_speaking.jpg NOT prosecutor speaking.jpg 
 
         The spacing can cause problems when the web server is attempting to locate that image  
         file and insert it into the document. 

 
3) When the photo is inserted, you need to then format it. For images that do not require a caption, this 
is as simple as applying a CSS style: 
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 Photo-right: Will “flush” the photo to the right, place a border around the image and 
automatically wrap text around the photo: 

 

 
 

 Photo-left: Will “flush” the image to the left, place a border around the image and automatically 
wrap the text: 
 

 
 

 
To Center A Photo… 
 
 Put an extra return in between two paragraphs where you want the photo to appear: 
 

 
 

 Now follow the same steps for inserting/uploading a photograph (pages 30-31). 
 
 
 
 
 



__________________________________________________________________________________ 
Q-Content User Guide |  Page 33 of 42 

 When the photo is inserted. Click on it and use the “Photo-Frame” style – boxed in the image 
below – and your image will be given a border. (page 14) 

 

 
 

  To center the photo, just click on it and then click on the center alignment option here: 
 

 
 
 
Inserting Photographs w/Cutlines 
 
Many photos can not simply be inserted on our website(s) with a cutline to provide some explanation. 
 
To insert photos that need to be accompanied by a cutline, use the good-old Content Template tool: 
 

 
 
1) Just as you would with any photo, first place your cursor at the point in the article where you want 
the photo. With the exception of photos that will be centered, this insertion point has to be at the 
start of a paragraph. Then you can click on the Content Template tool. 
 
I have formatted photo boxes for flushed-right, flushed-left and centered. Use the Content Template 
tool to insert these pre-formatted photo boxes: 
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These are hopefully self-explanatory and can be used on ALL our websites: main site, Sheriff, 
Prosecutor, Parks + Rec, COMBAT, etc. 
 
For the purpose of this manual, we’ll assume you want to “flush” a photo to the right: 
 
1) “Insert Template” the “Photo_Flush_Rt” Content Template, which will automatically insert this 
photo-box: 
 

 
 
Of course, the photo and cutline automatically posted here are just placeholders for the photo you’ll be 
inserting and the cutline you’ll be writing. 
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2) Click on the placeholder image and press delete: 
 

 
 
This will clear the space in the table for inserting your photo. But first… 
 
3) Resize the table to fit your photograph by right-clicking on the table and selecting the “Table 
Properties” option: 
 

 
 

 
Selecting “Table Properties” will open this “Table Wizard” window: 
 

 
 

In the width window, you want to change the number to whatever size your photo is + 15 pixels. For 
example, if your photo is 300 pixels wide, you want to change the Table Design width to 315 pixels. 
The extra 15 pixels is crucial for test wrapping purposes. 
 
Exception: If you are centering the photo DO NOT add the extra 15 pixels. 
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4) Insert your photo, making sure your cursor is in the upper right row of the photo-box/table: 
 
 

 
 

When your photo is inserted, you want to then click on the image and apply the “Photo-frame” style to 
place a frame around the image (page 33): 
 

 
 

 
5) Then you can highlight the cutline text and write over it with your new cutline: 
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One More Step Regarding All Photographs 
 
Once you’ve placed a photo and/or formatted it, there’s one more important step to take. 
 
Right-click on your images to open the photo “Properties” window. 
 
 

 
 
 
If you use the applied styles (CSS) or the Content Templates, you should have no reason to adjust 
Border Color, Border Width or Image Alignment. 
 
However, you must include the… 
 
Alt Text: Can be a brief tag to accompany the photo (“Prosecutor Jean Peters Baker”) 
 
Long Description: A more detailed description of the image for use with visual readers. 
                              (“Prosecutor Jean Peters Baker talks with a Kansas City police officer.”) 
 
These are both essential for the visual readers used by the visually impaired. These individuals 
can’t see the images, but their readers can read the descriptions to them – and providing these 
descriptions is crucial to having a website that complies with ADA guidelines. 
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Creating Links To Independent Content 
 
When you add new independence content to your website – e.g. a news article to the main site, 
Prosecutor’s site, Sheriff’s site or COMBAT site – remember that just because you have published that 
content and gone live with it, that independent content remains dependent (page 19) on having links it 
posted elsewhere on your website. 
 
The COMBAT, Sheiff, Prosecutor, Parks + Rec and main site all have what I call news index pages 
accessible via clicking on the “News” or “News & Events” button in their navigation – or in the case 
of Parks + Rec the “News” sub-menu option under “About Us.” 
 
Those pages are all essentially set up the same as the one on the main page: 
 

 
 

These are as the name indicates simple briefs – teasers, if you will – that include just enough 
information to give the reader a taste and hopefully entice them to click the “> MORE” link (page 17). 
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But you also usually want to post links to new content on your home page. This can be done by 
placing the content in a news slideshow (if you have a workable graphic): 
 

 
 
You will need to contact me for creating/adding to a slideshow. (page 42) 
 
OR… 
 
All of our sites’ home pages have spaces allot for including news briefs: 
 

 
 

I am creating Content-Template Tool templates (page 25) to provide pre-formatted news briefs for 
each of our websites. 
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Files and Documents 
 
To load a PDF or other document (Word, Excel, etc.) onto your site… 
 
1) Follow the same steps you take when editing/adding content, scrolling through the navigation to 
locate and open the right folder (page 7). 
 
2) Once you’ve located and opened the right folder, go to the “Fields and Document” tab: 
 

 
 

3) Go back to the File menu and select New > File: 
 

 
 
 
3) Load Files 
 
WHEN SAVING FILES (PDF’s, Word Documents, etc.)  – Do not use spaces. Instead use 
underscores: 
 
John_doe_complaint.pdf NOT john doe complaint.pdf 
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File to Upload: Select the file from you computer. 
 
File Title: You have to give it a headline just like you would a Content Title 
 
Description and keywords work exactly like the meta description/key words (pages 10). 
 
Click Add to upload another file. (You can load up to six files at one time.) 
 
When you have selected the last file, click “Upload” to upload the files. 
 
When the files are uploaded, you can click “Copy Hyperlink” to get the necessary information for 
creating a link to that PDF (e.g. /filestorage/8829/8837/diocese_closed_indictment.pdf) 
 

 
 
Links to a PDF are created like any other link (page 15) – with the target being a “New Window.” 
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Special Notes 
 
1) If you want to use a photo slideshow, contact me. This entails writing HTML code and inserting 
DIV’s. 
 

 
 

2) The same goes for inserting a video on your site: 
 

 
 

3) Finally, notify me – jloudon@jacksongov.org – whenever you intend to post a page on the website. 
I can review your drafts to assure they are properly formatted and ready for “publishing” – a.k.a. going 
live for public consumption. 


